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Chapter1 Introduction

1.1 EzCad2 Brief Introduction

1.1.1 Software Installation
The EzCad2 software run on an PC with 900 MHz CPU and 256 MB RAM at least. In

general, we recommend the fastest PC available. EzCad2 was developed in Microsoft Windows
XP and will run in Windows XP and VISTA

The installation of EzCad2 is very easy. Users simply need to copy EzCad2 folder that is in
the Install CD to hard disk, and then double click the Ezcad2.exe under the EzCad2’s directory to
run the software.

EzCad2 requires a software security device sometimes known as a 'dongle'. This device
plugs into the USB port on the PC. If there is no dongle or the dongle do not install correctly, a
caution will appears and the software will work at demo state. In demo state, we can evaluate the
software but we cannot save files and cannot control laser device.
1.1.2 Software Function
Main functions of the software:
 Users can design their graphics freely.
 Various types of fonts are supported. Such as TrueType, SHX, JSF(Single line font defined

by EzCad2), DMF(Dot Matrix Font), One-Dimensional bar code, Two-Dimensional bar
code , and so on)

 Flexible variable text: changes the text real time while in laser processing. Excel datasheet is
supported.

 Can through the serial port direct read text data
 Can through the network direct read text data
 Strong node editing function make the curve modification more easier
 The software can support 265 “pencils”, which used to draw graphic and can be set different

processing parameters.
 Common types of images are supported. (bmp, jpg, gif, tga, png, tif…)
 Common vector images are supported. (ai, dxf, dst, plt…)
 Image processing (Grayscale, White / Black Transformations)
 Powerful hatching functions, such as support round hatch.
 More convenient IO operations and more easier to harmonize the auxiliary equipments.
 Supports the dynamic focus (3 axis processing system)
 Supports directly the SPI G3 fiber laser and the newest IPG_YLP and IPG_YLPM fiber laser
 An opening language supporting system makes it easy to run the software in various

languages platform.
1.1.3 Interface Introduction

 Software starting interface
The picture (Figure 1-1) appears while running the program, and meanwhile the initial

operations takes place in the background.
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Figure 1-1 Program starting interface

 Main Interface (Figure 1-2)

Figure 1-2 EzCad2 Main Window
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1.2 About EzCad2 User’s Manual

1.2.1 Contents Arrangement

The User’s Manual will introduce each menu (File, Edit, Draw, Modify, View, Help) in turn.

1.2.2 Announcement
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Chapter 2 File Menu

The File Menu is used for common file functions such as opening, saving, importing images
from Twain equipment, etc. (Figure 2-1)

Figure 2-1 File Menu

2.1 New (N)

“New" is used to create a blank work space to construct objects, and its shortcut key is “Ctrl
+ N”1. When “New” is clicked, the software will close the documents which you are editing and
meanwhile create a new file. If the documents you are working on have not been saved yet, the
software will prompt if you would like to save it.

The icon of “New” in toolbar is . Click on this icon will achieve the same operation.
If you move the mouse cursor onto the icon mentioned above and keep it for a while, a piece

of prompt information( Tooltip ) will appear, which briefly explains the function of this icon, and
also there will be some detailed explanations appearing in the status bar in the bottom of the main
window. And if you move the mouse cursor onto “New” in File Menu will only show detailed
explanations in the status bar.

1 “Ctrl + N” refers to press the key ‘N’ while press the key ‘Ctrl’. The following contents do the same.



EzCad2UNI User’s Manual

5 All rights reserved

Reminder: In EzCad2 software, each icon in the Toolbar contains a function of showing
brief prompt information and displaying detailed explanation. Also, each icon has a corresponding
menuitem, and both the two ways carry out the same function. The User’s Manual will not
mention it again in the following chapters.

2.2 Open (O)

“Open” is used to load a saved “.ezd” file, and its shortcut key is “Ctrl + O”. (Figure 2-2)
When click “Open”, the software will pop an open-file dialog to ask you select the file you want
to open, See fig 2-2. When you select a valid “.ezd” file, the dialog would display the preview of
the file (you must have saved the preview when you save the file).

Figure 2-2 “Open” Dialog Box

The icon of “Open” in toolbar is .
The files saved with other file-format will not be opened by the “Open” command.
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2.3 Save (S) / Save As (A)

“Save” file is used to save the current state of a mark Document to disk. “Save As” is used to
write the current mark Document to disk by another name. Writing a file to its current name is the
same as the Save function.

Figure 2-3 “Save” dialog box

If the current Document has already been named, “Save” is selected to save it under the name
that was used to open the file, or the software will prompt to the user to choose a destination path
and type a name. Whether the current file is named or not, “Save As” will appear to ask for a new
name to save file, and the previous file will not be overwritten.

If you select “Save Preview Image”, you will see the preview when you open the file(refer to
“Open” function).

The icon of “Save” in toolbar is .



EzCad2UNI User’s Manual

7 All rights reserved

2.4 Print

“Print” is used to print the images you are working with.

2.5 Obtain Scan Images (M)

“Scan Images” is used to get digital graphic object from Twain device. When selected the
“Scan Images” function will prompt the user to choose a Twain device. (The Twain device listed
in the column should be those which have been legally installed in the computer.) When the
suitable device is selected, you can now insert a graphic object into the currently selected
Document. (Different devices show different prompts. Please consult the devices operation
reference.)

2.6 System Parameter (P)

“System Parameter” configures the software, and the icon of “System Parameter” in toolbar

is .

Users can use this command to change the default setting of Display, Save and Language, etc.
When selected, a dialog box will appear, and you can set the unit the software uses, the color

displayed, the work space’s parameter, the interval of auto save, the locale language, etc.
2.6.1 General

In “General”, common parameters can be configured. (Figure 2-5)
“Unit Type”: millimeter and inch are two options can be selected.
“Paste X” and “Paste Y”: the relative offsets to the previously object when paste.

“Grid”: show or hide the grid
“Grid Space”: adjust the distance in grid.
“ Enable Mark Mutex (EZCAD2MUTEX_MARKING) ” :This option is used to

synchronize the Ezcad program with third-party programs. If checked, the Ezcad software create a
mutex object named “EZCAD2MUTEX_MARKING”. The mark command cannot be executed
until the mutex is “signaled” by other programs. After marking, the mutex will be switched to
“nonsignaled” state by Ezcad software

“Execute when Ezcad starts”：The exe file appointed here will be executed when the
Ezcad software starts.
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“Execute when Ezcad Finish”：The exe file appointed here will be executed when the
Ezcad software ends

Input IO mask: user could choose IO port through input IO mask, for example, if want to
use IO 0,1,2,3, you can click 0,1,2,3.

Output IO mask: user could choose IO port through output IO mask, for example, if want to
use IO 0,1, you can click 0,1.

Figure 2-4 System Parameter

2.6.2 Color
“Color” is used to set the color of background, work space, guide line and grid, etc. Double

click the color stripe could change the color wanted. (Figure 2-5)
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Figure 2-5 Color Figure 2-6 Set the Work Space

2.6.3 Work Space

The set of the work space’s property contains setting the size, type and position at the work
space. (Figure 2-6)

The Work Space is the rectangle or circle area in the main interface window. This space is
corresponded with the available working field of the laser machine, and any object drawn in this
area will be marked in operation. Due to the limit of the field, those objects drawn out of this
space may not be marked.

2.6.4 Auto Save

“Auto Save” refers to the interval time between two automatic saves, and the initial value is
10 which means to save file per ten minutes. The file saved is named as ‘AutoSave.ezd’ in
EzCad2’s directory. (Figure 2-7)
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Figure 2-7 Auto Save Figure 2-8 Move-Rotate

2.6.5 Move-Rotate
See figure 2-8.

Nudge Distance: the distance that the object moved when pressing direction keys each time.

Big Nudge Scale: indicates the number the user wants to time the Nudge distance so as to
achieve further each time when synchronously press direction keys and “shift” key together

Rotate Angle: the angle the object rotates each time when press direction keys and “ctrl” key
together

Object’s Origin: when use “Put to origin” function, which point of the object should be put
on the origin.

2.6.6 Plug Manager

The list displays the EzCad software plug which has already been installed in the computer.
The users can activate or inactivate each plug. Press “blank” key or double click the plug name
will swtich the active state. (Figure 2-9) Changes will take effect in EzCad’s next start.
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Figure 2-9 Plug List

2.6.7 User manager
Uses in choosing whether to use the current software must to input the user password, as

shown in Figure 2-10
When enable “You must enter and password before

using”, the system default has a administrator and a
designer, the user can increase operator.

The jurisdiction of administrator is to use software
all functions

The jurisdiction of designer is to revise all software
function besides the user information

The jurisdiction of draftsman is to draw file, set
machine parameter, but can’t set user information,
system parameter and machine file.

The jurisdiction of operator is only could open
already completed document, cannot revise and preserve
the document, as well as revise the system parameter,
this may prevent the operator to change the system parameters to cause the equipment work by
mistake not to be normal.

After enter software with user, the file which name is login will show in folder, with user
name and user entering time.
2.6.8 Language

This item is used to change languages between Chinese and English. (Figure 2-11)
Changes will take effect when restarting the marking software.

Figure 2-10 user manager dialog box
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2.7 Recent File List

Below the menuitem of System Parameter, a list is displayed to show the latest Document
files opened, and the max amount of the file items is ten. There is no file listed if users have never
opened / saved any “.ezd” files, and “Recent File” is unavailable.

2.8 Exit (X)

Exit the EzCad software. When selected the Exit function will prompt the user whether to
save the files which have not been saved yet.

2.9 Object List

Object List is in the left side of the main interface window.
Marked objects are grouped into an object structure or ungrouped to many objects. (Figure

2-12)
When in marking process, system will follow the order to mark the objects listed.
Users can rearrange the list by directly dragging the object up/down or right keyboard to

change the marking order.
Users can double click the object bar to name them.

Figure 2-12 Object List

Figure 2-11 Language
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2.10 Object Properties

Object Properties are displayed in the left side of the main interface window

 X position: the X coordinate of the
point in the left button corner of the
object selected.

 Y position: the Y coordinate of the
point in the left button corner of the
object selected

 Z position: the Z coordinate of
selected object

 X Size: width of the object selected
 Y Size: height of the object selected

 : Lock the current width/height

proportion of the object selected. If
user changes the object’s size, system
will keep the X/Y ratio. Click the
button will switch to unlock state

 : The coordinate data (X position, Y position) is maped to which point of the

object.

Figure 2-13 Object Property

Figure 2-14 Array (X=3, Y=2)
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 Array: copy the current object and
arrange them to the destination users
want by setting the row|column number
and space
Count X: the count of the row
Count Y: the count of the column
Inc (mm): the space between each

row|column.
Figure 2-14 stands for the situation when
“X=3, Y=2”
Figure 2-15 stands for the situation when
“X=2, Y=3”

: set array’s row as marking precedence

: set array towards vertical direction as marking precedence

: Unidirection marking.

: Bidirectional marking

I/O Control condition: The system reads the input port first, and then compare whether the
current input singal is as the same as the object’s “I/O Control condition”, and if it does, the
current object will be marked, or, the system will skip the current object and handle next object.
Only four bits (0, 1, 2, 3) are available now. Each bit has three states. The grayed state means
skip this signal. The unchecked state means that if we want to mark this object then the signal of
this bit must be low level voltage (TTL compatibel). The checked state stands for the high level
voltage (TTL compatibel) needed.

: expect the high level voltage

: expect the low level voltage

: skip the signal

Figure 2-15 Array (X=2, Y=3)

Figure 2-16 Input Port
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Chapter 3 Edit Menu

“Edit Menu” carries out the editing operation of an object. (Figure 3-1)

Figure 3-1 Edit Menu

3.1 Undo (U) / Redo (R)

“Undo” will undo the last action that the user made in EzCad2. For example, if the user
deleted an object accidentally, clicking Undo will bring the program back one step to where that
item still existed. And the user also can select “Redo” to redo the last action which has just been
deleted.

3.2 Cut (T) / Copy (C) / Paste (P)

“Cut” will delete the object selected from EzCad2 and copy it to the clipboard. It can be
inserted back into the .ezd file later using “Paste” function. Note that it will be lost if other data is
copied to the clipboard.

“Copy” will copy the selected object to the clipboard and reserve the current object.

“Paste” will paste the object from the clipboard to current document file.

The shortcut keys of “Cut”, “Copy” and “Paste” respectively are: Ctrl+X, Ctrl+C and Ctrl+V.
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3.3 Combine / Uncombine

“Combine” will ignore all the selected objects’ curve properties and combine those objects
into a new curve combination with new curve properties. Same as other objects, this new
combination can be selected, copied, pasted and set properties.

“Uncombine” will get the combination back to the curve objects separately. The objects after
“Uncombine” may be different from those before “Combine”. “Undo” should be used to restore
the original objects

The feature Combine’s icon in Toolbar is , and the feature Uncombine’s icon in Toolbar

is .

The shortcut keys of “Combine” and “Uncombine” respectively are: Ctrl+L and Ctrl+K.

3.4 Group / UnGroup

When selected the “Group” function will keep the selected objects’ original properties and
make them into a new object, and this new group, as the same as other object, can be selected,
copied, pasted and set object properties.

“Ungroup” will turn the object which has just been grouped into previous situation. The
object which has just been grouped by more than 1000 objects will become 10 objects. If the
object is a vector file which has different pen color, it will become some objects according to
color.

The icon of Group in Toolbar is , and UnGroup’s is .

The shortcut keys of “Group” and “UnGroup” respectively are: Ctrl+G and Ctrl+U.

3.5 Hatch

“Hatch” is used to force EzCad to calculate the hatch fills for the current objects. The object
to be filled must be closed curve, and if you choose many objects to fill, these figures can be
objects nested mutually. Any two objects may not have intersectant parts (Figure 3-2)
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Figure 3-2 Hatch

(Objects on the left can be filled; The two rectangles on the right may get unexpected result for they

intersect each other.)

The icon of Hatch in Toolbar is , and when selected a hatch dialog box will appear as Figure

3-3 shows.

Mark Contour: whether to show and mark the current object’s contour or not

means when click ‘Mark Contour’, mark hatch line first then mark contour

means when click ‘Mark Contour’,

mark contour first then mark hatch line
Hatch 1 / Hatch 2 / Hatch 3: Users may have

three independent hatch parameters to hatch the
same object at the same time. Each set of hatch
parameters can be appointed a Pen No. which
stands for a set of marking parameters.

Enable: whether to permit the validity of the
current hatch parameter.

All Calc: Calculate all the selected objects as
a whole. This is an optimizing option. In some
cases the speed of marking may highly be raised. It
will take long time to calculate large, complex
objects. When not selected, the objects will be
calculated separately.
For example: draw three rectangles, line distance is 1mm, angle is 0.
1. Do not click ‘All Calc’, system will mark as the order in object list, mark hatch line in the first

rectangle then mark hatch line in the second rectangle, and so on.
2. Click ‘All Calc’, mark all the hatch line at one time, mark all the hatch that on the same line.
3. Marking result as follow fig 3-4:

Figure 3-3 Hatch
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Fig 3-4(a) do not click ‘All Calc’, the hatch line are not in the same line

Fig 3-4(b) click ‘All Calc’, hatch line are in the same line
Type of Hatch: (Figure 3-5)

Unidirection hatch: The hatch lines will be marked from left to right.

Bidirectional hatch: The hatch lines will be marked from left to right first, and then

from right to left.

Ring-like hatch: fills objects from the outside to the inside like a ring

Optimization two-way hatch: similar with bidirectional hatch, but the end of each end

connects.

Click the button will switch between the Unidirection, bidirectional, and ring-like hatch.
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Figure 3-5 Types of hatch

(The left object is being filled by Unidirection Hatch or Bidirectional Hatch, the middle object by

Ring-like hatch, and the right one is Optimization two-way Hatch)

Optimization Gong type hatch: similar with Gong, will jump in null place.

Gong type hatch Optimization Gong type hath

Above 5 types all can be changed by click the button , choose it according to different
application.

Angle: Hatch Angle stands for the angles between hatch lines and X axis, and Figure 3-6 is the
feature when the angle is 45 degrees.

Line Space: the space between two hatch lines
Edge offset: the distance between hatch lines and

the object’s outline (Figure 3-7)

Figure 3-6 Degrees
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Figure 3-7 Border Distance

(The left object shows the figure when Edge offset is 0 and the right shows when it is 0.5.)

Follow edge one time: draws outline one time around the hatch lines after filling (Figure
3-8)

Start Offset: the
distance between the first fill line and the border of the object

End Offset: the distance between the last fill line and the border of the object
Figure 3-9 shows the feature when it is filled.

Figure 3-8 Follow edge one

(The left object do not enable this option and the right one do.)
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Figure 3-9 Offset Distances

(The left figure is the object when the Start offset and End Offset are 0,

and the right figure is the object when the Start offset and End Offset are both

0.5.)

Average distribute line: The solution the starting and ending hatch line are non-average
distributes question when the object is hatched. After select this item, the software automatic
adjust the hatch line space in the user setting hatch line space foundation, will let the hatch line
average distribute.

Linereduction: The hatch line both sides reduction. (Figure 3-10)

NumLoops: The times of Ring-like hatch before the aclinicing hatch (Figure 3-11).

Figure 3-10 Linereduction

( The left figure is the object when the Linereduction is 0,the middle figure is the object

when the Linereduction is 0.5, and the right figure is the object when the Linereduction is -0.5)
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Auto rotate hatch: Refers to after every marking, the hatch line will fill the revolving angle
which we setted automatically to marking again. For example, angle is 0, auto rotate angle is 30,
the first mark angle is 0, the second is 30, the third is 60, and so on.

Undo Hatch: delet hatching
Hatch one by one: choose multi object and hatch together, after hatch, still independent

object.

3.6 To Curve

“To Curve” turns the current selected vector graphics object into curve object

3.7 To Dashed

‘To Dashed’ turns the current selected vector graphics object into dashed object, as fig 3-12

Fig 3-12 turn vector graphics into dashed object

Use could set the length of the line and the distance between two lines

Figure 3-11 NumLoops

( The left figure is the object when the NumLoops is 0,and the right figure is the object when the NumLoops is 2)
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3.8 Offset

Offset dist: the distance between the old curve and original object
After user set the offset distance, click on the right side of the object, object will move right, click
left side of the object, object will move left side.

3.9 UnGroup Text

Make the text into group according to each character, then object name of the group is the
name of the character.

Chapter 4 Draw Menu

“Draw Menu” consists of various common items for drawing, for instant, Dot, Line, Curve,
Polygon, etc. Draw Menu has a Toolbar correspondingly, and all the operations can be achieved
by pressing the icon on the Toolbar. For example, as Figure 4-1 shows, when you have selected
the drawing command or the icon in Toolbar, the Present Command Toolbar on the top of the main
window will be changed to show some options of the current command.

（a）

Figure 4-1 Draw Menu

（The three pictures above stand for: (a) Draw Toolbar; (b) Draw Menu; (c) Command Toolbar）
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4.1 Point (D)

To draw a dot in the working space is one of the easiest drawing operations. When selected,
the mouse pointer will be changed into a cross feature, and users just press the left button of the
mouse in an appropriate place, a dot can be drawn. Also users can draw more dots by pressing the
left button, when it is finished, user can press the right button of the mouse to end the drawing
command, and then the last dot drawn is displayed as selected object.

Under dot drawing mode, the Present Command Toolbar will be displayed as:

used to draw a dot

If users press button , a set of dots with equal distance will be placed along a curve. Click

this button, the tool bar becomes:

Point num: the amount of dots settled on the curve

Point dist: the distance between the two bordered dots

Start Offset: the distance between the first dot and the beginning of the curve
Note: if it can’t carry all the points, system will put remaining points from the start of the curve
till finish all the points use set in ‘Point num

’use can set point distance as user need, system will calculate point num as the point

distance.

4.2 Curve

To draw a curve, users can select command “Curve” in the Draw Menu or click the

icon . (Figure 4-2)
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When command “Curve” selected, users can draw free curves by pressing the left button of
the mouse and drag it.

When command “Curve” selected, users can move the mouse to the nodes on the middle of
the curve and press the left button of the mouse to delete the current node.

When “Curve” commands selected, user can move the mouse to the node on the beginning of
the curve and press the left button of the mouse to close the current curve automatically.

When command “Curve” selected, users can move the mouse to the node on the end of the
curve and press the left button of the mouse to change the node of the current object into “sharp”.

When command “Curve” selected, users can move the mouse to the points which are not
nodes and press the left button of the mouse to add a node to the current position of the curve.

4.3 Rectangle

To draw a rectangle, users can select command “Rectangle” in Draw Menu or click the

icon .

Under the command “Rectangle”, users can press the left button of the mouse and drag it to
draw a rectangle.

Figure 4-2 Draw a Curve
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Under the command “Rectangle”, users can draw a square
by pressing the left button of the mouse and drawing it when
press “Ctrl” key synchronously.

After drawing and selecting, the Properties Toolbar will
display a feature like Figure 4-3 shows.

Arc radius: This refers to the smooth degree of the
rectangle’s four corners, and when the degrees are 100%, then
the rectangle changes into a circle.

All corner Round: When selected, users can change the
angles of the four corners at the same time just by changing one
of them.

NOTE: After changing the parameters in the Properties
Toolbar each time, we must click “Apply” button to update
the object with new parameters.

4.4 Circle

To draw a circle, users can select command “Circle” in the Draw Menu or click the

icon .

Under the command “Circle”, users can press the left button and drag it to draw a circle.
After drawing and selecting, the Properties Toolbar will display a feature like Figure 4-4

shows.

Diameter: the diameter of the circle
Starting Angle: the angle between the starting

point and the centre of a circle

: This figure refers to the drawing

direction of the circle is clockwise.

: This figure refers to the drawing
direction of the circle is anticlockwise.

4.5 Ellipse

To draw an ellipse, users can select command “Ellipse” in Draw Menu or click the icon.

Figure 4-3 Rectangle Properties

Figure 4-4 Circle Properties
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Under the command “Ellipse”, users can press the left button of the mouse and drag it to
draw an ellipse.

Under the command “Ellipse”, users can draw a circle by pressing the left button of the
mouse and drawing it when press “Ctrl” key synchronously.

After drawing and selecting, the Properties Toolbar will
display a feature like Figure 4-5 shows.

Start Angle: the angle between the starting point and the
centre of an ellipse

End Angle: the angle between the ending point and the centre
of an ellipse

: This figure refers to the drawing direction of the

ellipse is clockwise.

: This figure refers to the drawing direction of the
ellipse is anticlockwise.

4.6 Polygon

To draw a polygon, users can select command “Polygon” in Draw Menu or click icon .
Under the command “Polygon”, users can press the left

button of the mouse and drag it to draw a polygon.
After drawing and selecting, the Properties Toolbar will

display a feature like Figure 4-6 shows.

Edge Num: This item indicates the number of the
polygon’s borders, and that is at least three. Normally the
border number is less than ten, and with borders more than ten
the polygon will look like a circle.

: When selected, the current polygon to be drawn will
be a convex polygon.

: When selected, the current polygon to be drawn will
be a star.

4.7 Text

Figure 4-5 Ellipse Properties

Figure 4-6 Polygon Properties
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Typing text directly in the workspace is supported in EzCad2, and many types of fonts are
supported. To type text, users can select command “Text” in the

Draw Menu or click icon.

Under the command “Text”, users can set up a starting point
at any position wanted in the workspace to type characters by left
click mouse.

4.7.1 Character Properties

When selected, the Properties Toolbar will display a feature
like Figure 4-7 shows. Users may change the characters by typing
in the text box.

EzCad2 supports five types of text. (Figure 4-8)
When users select a type, a font list under that type will

appear to show all the available fonts. Figure 4-9 is the list of
TrueType.

Figure 4-10 is the list of Barcode Type.
Height: the average height of characters

: Figure 4-11 shows the dialog box after clicking

this icon.

: When selected, the current text aligns left.

: When selected, the current text aligns

center.

: When selected, the current text aligns

right.
Bold: When selected, the current text become
bold.
Italic: When selected, the current text become
italic.
Enable the same width character: make the
width of all characters the same
Char Width: the average width of characters
Char Angle: the degrees the characters incline
Char space: the distance between characters
Lines space: the distance between rows
Empty char width: the width of empty char

4-7 Character Properties

Figure 4-8 Types of Text

Figure 4-9 TrueTpye List
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4.7.2 Curve text function

EzCad2 support curve text function, if the user draw text near enough from the curve,

the text will arrange along the curve. When current text is curve text, click , fig 4-12

will pop-up:

Figure 4-10 List of Barcode Type

Figure 4-11 Character Options
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mean text will be parallel with

the curve, as fig 4-13.

Fig 4-13 normal arrange

means text will be vertical with

the curve, as fig 4-14.

Fig 4-14 vertical arrange

means the base line of the text is superposition with the curve, as

fig 4-13.

means the top of the text is superposition with the curve, as

fig4-15.

Fig 4-12 curve text
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Fig 4-15 top arrange

means bottom of the text is superposition with curve, as fig 4-16.

Fig 4-16 bottom arrange

means middle of the text is superposition with curve, as fig 4-17.

Fig 4-17 middle arrange

means text stay on the curve freely along with the curve, the

position of the text is up to as fig 4-18.
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Fig 4-18 freely arrange

put text on the other side of the curve, after this function, fig 4-13 will like fig 4-19.

Fig 4-19 put text on the other side of the curve

when put text on circle, we use this function.
Base angle: means the angle of the base line of the text.
Angle range limit: when we click it, no matter how many characters we input, system will

compress all the characters in the limit angle, as fig 4-20.
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Fig 4-20 limit the angle as 45

4.7.3 Circle Text

EzCad2 supports circular text, after select in the figure 4-11, the text will align

according to the user definition circle diameter.
The demonstration graph in Figure 4-12 is according to
Figure 4-11 parameter making.
Base angle: The benchmark of the text aligning the circle.
Angle range limit: When checked, no matter how much
chars that users type in, the text will be limited in the angle
range. (Figure 4-13)

Figure 4-13 Comparison of Two Texts (Limiting Angle is 45 degrees.)

Figure 4-12 Circle Text
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4.7.4 Barcode Text

When users click the icon , a dialog box will be displayed as Figure 4-14 shows.

Figure 4-14 Barcode Text

1. Sketch Map
The sketch map is that the current barcode will look like.

2. Barcode Information
The barcode explanation shows some information about the current barcode’s format,
and if users are not very clear with the format, it is recommended to read the tip first to
get to know what types of characters is valid.

3. Text
This item refers to the text to be made into barcode. And if the characters users types in

the Text space is valid, there will be a cross selected in which shows the
current characters are valid for being made into a barcode.

4. Show Text
Whether to show a corresponding text under the barcode (Figure 4-15)
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Figure 4-15 Show Text

Hatch：The text is hatched as the setting of hatch in the show text if the hatch is selected;
otherwise the hatching is the same as barcode.
Font: The font of the current characters to be displayed
Width: the width of the characters
Height: the height of the characters
Text Offset X: When selected and set up, the text displayed under the barcode will be
moved towards either the positive or the negative directions of X axis.
Text Offset Y: When selected and set up, the text displayed under the barcode will be
moved towards either the positive or the negative directions of Y axis.
Text Space: the space between characters

5. Quiet:
Refer to the size of the barcode’s blank area, when let the barcode “Reverse” valid.

 One-Dimensional Barcode
This kind of barcode consists of bar and space one by one. The barcode information is
carried by different width and position of the bars and space, and the information
volume they carry is decided by the width and the precision. Wider the barcode is, more
the bars and the space included, and more information carried. This kind of barcode
technology can store information towards only Unidirection through permutation and
combination of the bars and the space, and so it is called one-dimensional barcode.
Figure 4-16 shows a feature of parameter setting when a one-dimensional barcode is
chosen.
CheckNum: This refers to whether the current barcode needs verify code. Users can
freely choose which barcode they would like to add verify code on, and users have the
decision whether to use the verify code or not.
Reverse: This refers to whether to reverse the parts which should be marked into the
unexpected parts of an object. This function is used in some materials which appear
light color after the marking.
Bar Height: the height of the barcode
Narrowest Width: This refers to the width of unit bar. Commonly a one-dimensional
barcode consists of bars with four types of width and space with four types of width, 1
\ 2 \ 3 \ 4. The narrowest bar’s width indicates the width is 1 unit.
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Interchar space 

Figure 4-16 One-Dimensional Barcode Parameter

Setting
Figure 4-17 Characters’ Distance

Interchar space: It is prescribed that some barcodes have distance between characters. (e.g.
Code 39) This parameter is used to set this like Figure 4-17 shows.
Use Inter Hatch Line: If the facula diameter of laser bean is big, there will be a half facula
over boundaries after common hatch, then the code gun can not distinguish because actual
marking width is bigger than design width. So we specially design this hatch. The hatch line
is bow line and don’t have contour.
Laser Bean Diameter: The size of laser facula.
Hatch Line Distance: The space between two hatch lines
Scale:

Bar: setting the width of one bar.
Space: setting the width of the space,

Quiet:
Refer to the size of the barcode’s blank area, when let the barcode “Reverse” valid. The
actual size of the blank area is the multiple of the unit bar.

 Two-Dimensional Barcode

1. PDF417 Barcode

Figure 4-18 PDF417 Barcode Figure 4-19 Compress PDF417 Barcode
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PDF is the abbreviation of the Portable Data File. Figure 4-18 is the demonstration of
PDF417 Barcode and Figure 4-19 of the Compress PDF417 Barcode. Figure 4-20 is the
parameter setting of the PDF417 Barcode.

Bar Height: the height of the barcode
Narrow Width: This refers to the width of the unit bar.
Level: the Error-Checking Level of PDF417 barcode, from 0 to 8
Lines and Columns: the lines and Columns of PDF417 barcode

Figure 4-18 shows a feature of a barcode with the row’s number is four and the column’s is four.

Figure 4-20 PDF417 parameter

2. Data Matrix Barcode:
Data Matrix is a kind of two-dimensional barcode based on Matrix, and currently there are

two types: Ecc000-140 and Ecc200. EzCad2 supports Ecc200 at present.
Figure 4-21 shows the parameter setting of Data Matrix Barcode.

Figure 4-21 Data Matrix Barcode Parameter Setting Figure 4-22 Data

Matrix Barcode

Size

Figure 4-23 Data Matrix

Barcode Width

Data Matrix has various fixed size, and users can choose what they want. If the smallest
size is chosen, the system will automatically select the smallest frame to fit the all text users have
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typed.
Narrow Width: the width of the unit bar (Figure 4-23)

3. QRCODE Barcode:
QRCODE Barcode is two dimensional (2D) code format. The character set includes all

ASCII values. There are no size restrictions.
The figure 4-24 ，4-25， 4-26 are the parameter of QRCODE Barcode.

Figure 4-24 QRCODE Barcode Figure 4-25 QRCODE Barcode text setting

Figure 4-26 QRCODE Barcode Parameter Setting

4. MicroQRCODE
Simply of QR code

5. CHINESE-SENSIBLE CODE
Chinese 2D barcode, include all the ASCII and chinese words
6. USER DEFINE Code:
USER DEFINE Code is user can define code format by self. Figure 4-27 and figure 4-28 are

the demonstration of user defines code.
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Figure 4-27 USER DEFINE Code Parameter Setting

Figure 4-28 USER DEFINE Code

4.7.4 Variable Text

The function of variable text is available after is selected.

Variable Text is a disciplinary and dynamic text which can be customized during the operation.
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Figure 4-29 Variable text attributes

The adjacent character distance in current text character arrangement situation

What the adjacent character spacing's computation refers to is left side the

character right boundary to the right side character left boundary distance, see the figure 4-30:

Figure 4-30 Calculate spacing according to character boundary

What the adjacent character spacing's computation refers to is left side the

character center to the right side character center distance, see the figure 4-31:
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Figure 4-31 Calculate spacing according to character center

is the special array uses in the variable text array, when uses this array the time text

to change automatically, but 2.11 object property said the array will not change the text object, this
is the difference about these two array.

Inside the EZCAD2 international edition the variable text is a character string according to
successively the order by each kind of different real-time change text element. The user may
according to need to increase each kind of variable text element, may carry on the order of rank to
the text element.

After the user click “increases”, the system will display a dialog box as Figure 4-32 shows.
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Figure 4-32 Text element dialog box

Currently EzCad2 supports 9 types of variable text:
Fixed text: refers to the fixed invariable element in the operating process.
Serial number: The system will change the text according to the fixed increment when in

the operating process.
Date Code: When the operation is taking place, the system will automatically pick up the

date information from the computer as a new formed text.
Time: When the operation is taking place, the system will automatically pick up the time

information from the computer as a new formed text.
TCP/IP communication: When the operation is taking place, the system will pick up the text

from the network
Serial communication: When the operation is taking place, the system will pick up the text

from the serial port
File: The system will seriatim read what to be marked in the customized text file line by line.
Keyboard: Users can type text to be marked through keyboard when the marking is in

process.
SQL database: The system will seriatim read what to be marked in the database line by line.

Fixed text

The fixed text is refers to the fixed invariable element in the operation process.

Figure 4-33 Fixed text

Change Line character: uses in variable text, can resolve the question about multi-text

must branch marking. When application, increases one change line character between two variable
texts, the software according to the change line character position automatic text branch. If many
texts need to divide into the multi-lines, only need in the behind where want to branch's text to



EzCad2UNI User’s Manual

43 All rights reserved

increase one change line character.

The fixed text has a special option is , when chooses this item, the system uses

the current user name to replace the fixed text automatically.
Below explains with examples the situation needs to use in the fixed text the user name

function.
If the present must process one batch of work piece as shown in Figure 4-34, because the

worker is every day three number of runs in turn, in order to control the quality to need each
operator marks his own name, does not process the part in the work piece. Because only the
designer and the administrator have the jurisdiction of change processing document, the operator
is unable to change the processing document to increase own name, this time needs to use in the
fixed text the user name function.

The administrator must enable “You must enter and password before using” (see Chapter
2.6.7), then sets a user name and the password for each operator. The designer completes the
processing document which as shown in Figure 4-34, the last text sets the user name in the object
list. After like this each operator goes to work, after opening EZCAD2, must input own user name
and the password, in processes this document time, the system alters to automatically the last text
operator's name.

Figure 4-34 the processing example has the user name in the fixed text

Serial number

Serial number text is a text which is changed according to the fixed increment when in the
operating process.
When selected, a serial number parameter setting will automatically appear in the variable text
dialog box. (Figure 4-35)
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Figure 4-35 Serial number parameter definition

Mode: The mode current series number used, see the figure 4-36.

Figure 4-36 Serial number mode

Dec: Series number carry according to decimal system, the effective character is from zero to
nine.

HEX: Series number carry according to capital letter hexadecimal system, the effective
character is from A to F

hex: Series number carry according to small letter hexadecimal system, the effective
character is from a to f

User define: The series number carry defines according to user define system, after selecting,
the system will display a dialog box like Figure 4-37 shows.
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Figure 4-37 User define other number system dialog box

The user can define carry ways discretionary between 2 to 64, only needs to define the max
number, and then revises each serial number correspondence the text
Start SN: This item indicates the first serial number to be marked at the present
Current SN: the serial number to be marked at the present
Limit: when mark the limit serial number, it will back to start serial number automatically
Increment: the increment of the current serial number. The value may be plus or minus
When the increment is “1”, and if the starting serial number is 0000, there will be an increment
“1” added on the previous serial number. For example, 0000, 0001, 0002, 0003 … 9997, 9998,
9999, and when it comes to 9999, the system will be back to 0000 automatically.
When the increment is “5”, and if the starting serial number is 0000, the serial number is: 0000,
0005, 0010, 0015, 0020, 0025 …
Others can be analogized by this.
Marks per: the marked number. This item indicates how many times every serial number is
marked before changing.
Current num: the marking time of current serial number, when marking number equals to marks
per, it will turn to 0 automatically

if click it, software won’t mark special number in special digit.

won’t mark numbers end with 4, * means any digit.

Reset: The number will become the start SN in the set time.
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Date Code

When the operation is taking place, the system will automatically pick up the date
information from the computer as a new formed text.

When selected, a date parameter definition will be shown in the dialog box automatically. As
Figure 4-38 shows, users can directly choose the type they prefer.

Figure 4-38 Data parameter definition

Year－ 2008: Use computer clock's current year for corresponding text, the form is four
characters.

Year － 08: Use computer clock's current year for corresponding text, the form is two
characters: latter two digits are effective of the year.

Month－ 07: Use computer clock's current month for corresponding text, the form is two
characters.

Day－04: Use current computer clock's each month's date for corresponding text, the form is
two characters.

Day－ 186: The use current computer clock this day takes the corresponding text from
January 1 number of days, the form is three charactes. (What 001 represent is on January 1 , what
002 represent is on January 2, what 003 represent is on January 3, ex analogia)

Day of week－5: Use current computer clock's week date for corresponding text, the form is
one character

Week of year－27: The use current computer clock this day is this year's several week for
the text which corresponds, the form is two characters (from January 1 to January 7 is 01, from
January 8 to January 14 is 002, ex analogia)

Date: When system read computer clock's date, needs to add on the the displacement date is
the finally date, this function mainly uses in the work piece processing having the production date
and guaranteeing nature date professions and so on food.

User-defined month character: When selected the month as the corresponding text, the
Figure 4-39 will be shown. Users can define the month character, changes to other characters that
no longer uses the digit which the software defaulted, only needs double-clicks the selected month,
input the month other characters, finally the month which shown on the software workspace is
with the input character.
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Figure 4-39 User-defined month character

click it, follow dialog will show, user could define year as user need

Time

When the operation is taking place, the system will automatically pick up the time
information from the computer as a new formed text.

When selected, a time parameter definition will be shown in the dialog box automatically. As
Figure 4-40 shows, users can directly choose the type they prefer.

Figure 4-40 Time section

Hour－24: Use current computer clock's hour for the corresponding text, the time format is
24-hour-setting

Hour－12: Use current computer clock's hour for the corresponding text, the time format is
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12-hour-setting
Minute: Use current computer clock's minute for the corresponding text.
Second: Use current computer clock's second for the corresponding text.
Time Section: Divides into 24 time sections one day of 24 hour, the user may define each

time section is a text. This function mainly uses in the work piece the processing needing to have
the number of runs information.

TCP/IP communication

When the operation is taking place, the system will pick up the text from the network.
Notice: The network interface in here is the network interface uses in TCP/IP agreement.
When the user selected the “TCP/IP communication”, the parameter defines will display

automatically in the dialog box, see the figure 4-41:

Figure 4-41 TCP/IP communication parameter definition

IPAddress: select the IP address which from reads the data
Port: select the port the TCP/IP communication used
Command: When the system processes to this text object, the system through the

network interface to transmit this order character string to a computer assigned the IP address,
request the computer sends the character string needs to process at present, the system will not
return until the computer replied, after the response of the computer, the system will process the
returns text automatically.

Unicode: After choosing this option, the system to the computer transmission which and
the read character is the Unicode form, otherwise is the ASCII form.

The following example showed how to use this function:
Now has a customer to process 10000 work pieces, on the work piece the marking content is

a text, but each work piece must process the text content is dissimilar, therefore, before each work
piece processing, must real-time read the processing content through the network from the local
area network a computer server (IP: 192.168.0.1 port is 1000) on.

1． Open ezcad2 to establish a text object, adjust the text size, the position and the
processing parameter.

2． Choice the text object, select the “enables variable text”, click the “increase” button, the
system will spring a Figure dialog box as 4-32, select TCP/IP communication, set the
network interface parameter, the IP address parameter fills in server computer's IP, here
is 192.168.0.1; the port parameter sets to use in the communication the port number, here
is 1000, the network interface parameter must identically with the server computer on ,
otherwise it will cause to be unable communication.

3． Set the command is TCP: Give me string.(This command may for the random server
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definition command)
4． After closing the dialog box, click the application button.
5． Click F2 to start to process, the computer will send the command “TCP: Give me string”

to the server immediately through the net mouth, and waited for that the server will
return.

6． After the server discovered the network interface receives the command is “TCP: Give
me string”, reads the database immediately to obtain the text which the current must
process, then gives the local computer through the network interface reply.

7． After the local computer obtains the text which must process, changes the processing
data to transmit immediately to the marking board.

8． After the marking board receives the processing data, control the machining to mark the
work piece immediately.

Flow chart as shown in Figure 4-42:

Figure 4-42: TCP/IP communication flow chart

Serial communication

When the operation is taking place, the system will pick up the text from the serial port.
When the user selected the “Serial communication”, the parameter defines will display

automatically in the dialog box, see the figure 4-43
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Figure 4-43 Serial communication parameters

Port: the port which computer and peripheral equipment connection used
BaudRate: the BaudRate which the serial communication used
DataBits: the DataBits which the serial communication used
StopBits: the digits of StopBits of which the serial communication used
Parity: select the digits of Parity which the serial communication used
Command: When the system processes to this text object, the system through the serial port

to transmit this order character string to a peripheral equipment, request the peripheral equipment
sends the character string needs to process at present, the system will not return until the
peripheral equipment replied, after the response of the peripheral equipment, the system will
process the returns text automatically.

Unicode: after choosing this option, the system to the computer transmission which and the
read character assigns is the Unicode form, otherwise is the ASCII form.

The following example showed how to use this function：
Now has a customer to process 10000 work pieces, on the work piece the mark content is a

text, but each work piece must process the text content is dissimilar, therefore, before each work
piece processing, must real-time through the serial port (On serial port parameter establishment
server: the BaudRate is 15200, the DataBits is 8, the StopBits is 1, the Parity is NO)the content
which the read must process to other server on.

1. Open ezcad2 to establish a text object, adjust text size, the position and the processing
parameter.

2. Choice the text object, select the “enables the variable text”, click the “increase” button,
the system will spring a Figure dialog box as 4-32, select Serial communication, the
setting of serial port parameter must with server's serial port parameter correspondence
(the BaudRate is 15200, the DataBits is 8, the StopBits is 1, the Parity is NO), the port
for current the port number which uses with it connected server, the serial port parameter
must establish identically with the server computer on

3. Set the command is COM: Give me string. (This command may for the random server
definition command).

4. After closing the dialog box, click the application button.
5. Click F2 to start to process, the computer will send the command “COM: Give me

string” to the server immediately through serial port and wait for that the server will
return.

6. After the server discovered the serial port receives the command is “COM: Give me
string”, reads the database immediately to obtain the text which the current must process,
then gives the local computer through the serial port reply.

7. After the local computer obtains the text which must process, changes the processing
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data to transmit immediately to the marking board.
8. After the marking board receives the processing data, control the machine to mark the

work piece immediately.
Flow chart as shown in Figure 4-44:

Figure 4-44 Serial communication flow chart

File

Txt files and Excel files are supported now.
1．Txt files

When select TXT file, a dialog box as
Figure 4-45 shows will be displayed
to ask for the file’s name and the
current text’s line number.

Auto reset: If checked, the line
number will change to 0 automatically
when reach the last line. The next
mark will start from the first line
again.

Read all lines: When processes to the text document direct read entire document.
2．Excel files

Figure 4-45 TxT document parameter definition
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Figure 4-46 Excel document parameter definition

We have to appoint the file name, Field name, Line number to tell the software which cell in
the excel table will be mark.

File name: The text string of the first row in the datasheet1. This parameter indicates which
column will be marked.

Keyboard

The keyboard element is the text which must process from the keyboard entry by the user,
when select the keyboard element, a dialog box as Figure 4-47-a shows will be displayed to ask
for the user set the keyboard element parameter.

Fixed char count: user must

input string with digit equals to this
count

Prompt: In the processing, the

system will spring the input dialog
box which ask for the user input the processing text when meets the keyboard variable text, like
the figure 4-47-b shows, this time the user direct by-hand input the text.

Set Pen Param: When selected, we can get power, speed, frequency from the keyboard entry,
only through setting pen*.power, pen*.speed or pen*.freq. The “*” is number of pen.

The keyboard element function uses frequently in this kind of situation when the processing
needs the real-time input to the processing content. If the customer present need processes one
batch of work pieces, on each work piece is printed with a bar code, when processing needs the
user with the bar code scanning gun real-time scans the work piece to read the content on the bar
code, then with laser to mark to the work piece assigns in the position, at this time can use the
keyboard element function. At the processing time system springs like the figure 4-47-b shows the
dialog box, the operator with the bar code scanning gun scanning bar code work piece on, the bar
code scanning gun inputs the read content to the dialog box inside and closes it automatically, then
the system will start to process the content read a moment ago automatically .

Figure 4-47-a Keyboard element parameter
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Figure 4--47-b Keyboard input text dialog box

Advance

Click “Advance” then the dialog box will be displayed shown as Figure 4-48
Enable fixed width: no matter

how long is the text, the length will be
limited in this range.

Mark Self: In certain situations,
the user need division the input
keyboard text then places them the
different position to mark,
simultaneously also needs to mark this
keyboard text, application this
function can achieve this requirements
After set the parameters of the
division character, select “Mark Self”,
when the marking, marks the division
character besides, will also mark all
keyboard text in the corresponding
position which input a moment ago.

At present, the Advance function has split character string function. The following processing
example will explain it.

For example: In Beijing Olympic Games ticket prints on the bar code has the sports field
entrance number as well as the seat number information, but the human is unable to distinguish
the bar code directly, must use the laser to mark this information to the ticket assigns in the
position. At this time we may use the split character string function, through the bar code scanning
gun read the series number, then split the series number automatically, and processes to assigns the
position. As shown in Figure 4-49 the Olympic Games ticket sketch map, the bar code following
serial number is the bar code content, the serial number altogether has 7 characters, first 3
character expression entrance number, latter 4 character expression seat number, what bar code
scanning gun read-out is the entire character string, EZCAD2 must split the reads series number
according to the request and puts to assigns the position automatically.

Figure 4—48 Advance function dialog box
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Figure 4—49 Olympic Games ticket sketch map

1．First establishes a keyboard variable text:

establish text—→enable variable text—→add—→keyboard, such as the figure 4-50-a:

Figure 4-50-a Keyboard

2. Input prompting message, click “OK”, then we can obtain the figure 4-50-b.
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3. Select “Advance” then the

dialog box will be displayed shown as Figure 4-48.
4. Selects “enable split string to change other text entity” to revise has assigned the name text

object, click “Add” then the dialog box will be displayed shown as Figure 4-50-c.
Index of the first character in string: In the TEXT1 text the first character is the several

characters in the keyboard variable text character string.
The number of characters to extract from string: extract how many characters in the

keyboard variable text's character string.
The name of text entity which you want to change: The fixed text name the split read's

character is at.
Add Char Mode: click it then add the split characters behind of the text

Figure 4-50-c Add split character string parameter

Here increases two conditions, one is revises TEXT1 the object, starts from the 1st character
to take 3 characters, other one is revises TEXT2 the object, starts from the 4th character to take 4
characters. At last the result like the figure 4-50-d shows the dialog box.

5. Set two text objects and
change its name TEXT1,
TEXT2. Here should pay
attention to the keyboard
variable text must arrange
before two fixed texts in the
object list, the TEXT1 object
places the position which the
entrance number must
process, the TEXT2 object
places the position which the
seat number must process,
then set the processing
parameter.

6. Click “Mark” then the dialog
box will be displayed shown as Figure 4-50-e, the user use bar code scanning gun
scanning the ticket's bar code, the system will put the series number division to inside
TEXT1 and TEXT2 and process automatically.

Figure 4-50-b Keyboard text parameter

Figure 4-50-d The result add split character string
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Figure 4-50-e Keyboard input prompt dialog box

4.8 Bitmap

To add a photo, users may select command “Bitmap” in the Draw Menu or click icon in

the Toolbar

Figure 4-51 Add a photo

Then the system will pop a dialog box as Figure 4-51 shows to open a graphic file.

The current supported graphic file formats are: Bmp；Jpeg, Jpg；Gif；Tga；Png；Tiff, Tif；
Show Preview: When users select a graphic file, there will be a preview displayed in the

dialog box.
Put to center: put the photo’s center in the origin
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When finishing adding a photo, a “Bitmap” parameter setting will appear in the Property

Toolbar as Figure 4-52 shows.

Dynamic file: whether to reread files when in process.
Fixed DPI: When selected, the system will fasten the

unfixed DPI of dynamic photo. The higher the DPI’s level is,
the closer the dots gather; and the photo’s precision is better,
then the marking time is longer.

DPI: dot per inch; 1 inch is about 25.4 millimeters
Fixed Size X: When checked, the width of the dynamic

photo will be preserved in an appointed size, and if unchecked,
the photo’s width will be the original size of the photo.

Fixed Size Y: When checked, the height of the dynamic
photo will be preserved in an appointed size, and if unchecked,
the photo’s height will be the original size of the photo.

Fixed position: the benchmark the dynamic photo based
on while in size changing

Image Manipulation:
Invert: run negative effect on photos (Figure 4-53)

Figure 4-53 Invert Effect (Left is original.)

Gray: change color photos into grey of level 256 (Figure 4-54)

Figure 4-52 Bitmap Parameter
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